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1. Launching
the program

To launch Art•lantis Render and open a sample document.

• Double-click on the Art•lantis Render icon. 

• Open the document "Room Start", located in the  “Tutorial 1”
sub-folder, within the “Tutorial” folder.

Two information windows appear in succession in the middle of
the screen, indicating the phases of the loading process:  reading
points (5654), reading objects (9199), sorting faces (9199) and
calculating projections (224).
The loading process is represented by sliding gauges, so you can
watch its progress.

O b j e c t i v e

Macintosh

Windows
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Once Art•lantis Render has loaded, it calculates the image, which
is displayed progressively in the preview window.  

When the display is finished, you may begin to work.

Two windows will be displayed on your screen:  to the right, the
preview window containing the scene and to the left, the window
for adjusting the first shader, which corresponds to the first
material on the list.

Info: What is an Art•lantis  Shader?

“Shader” is the term used to describe the appearance 
of an object’s surface.  Each object has a material, 
made up of a color and basic characteristics (matte 
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or shiny, for example), to which you can add a 
shader to give the object a much more sophisticated 
look:  photorealistic. 

Remark :
In the “Materials list” window, you’ll find a list 
of the names which correspond to the different 
materials that were assigned to each object in the 
modeling program (table, wall, etc...).  One word of 
caution:  these materials are not 3D objects, because 
the same object can be made up of several materials,
and the same material can be applied to several 
different objects.   (A wall and a ceiling can be 
made up of the same material, for example.)

You can select any object in the preview window by clicking
directly on it : 

• hold down the mouse button and drag the cursor onto 
the object in the Preview window

• keep the cursor on the object for 1-2 seconds

The object you have selected will be displayed with the material
color that was assigned to it, while all other objects in the scene
will be dimmed.

The interface is intuitive and interactive.
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To select an object and modify its color with a palette, or
“picker”.

Art•lantis Render automatically defines the object’s default
material as the first one found in the Materials list.

• Move the cursor inside the “Picker”.

The material’s color changes immediately in the preview window.

Between the color patch and the “picker”, you’ll see the saturation
bar (for more information about the saturation bar, refer to the
User’s Guide).

you have just completed your first scene adjustment.  If it didn’t
seem very difficult, you’ll be pleased to know that the other
adjustments will not be any more complex than this one! 

2. Modifying
colors 

O b j e c t i v e
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3. The
shaders
library

To open the Library and master the tools for navigating the
shader families.

You can now customize your image by choosing shaders and
attributing them to the scene.

• Open the shaders library by selecting “Library” in the
Windows menu.

The library is made up of numerous families.
The current family is made up of one or several “pages” of
shaders whose names appear below their icons:  Wood, Chrome,
Plastic, Marble, etc.   

O b j e c t i v e
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To view a family:  

• Click on the Families List at the bottom of the window and hold
down the mouse button.   
• Drag to the name of the family you want to view. 
• Release:  the family is displayed in the window.

To display the Families list:   

• Click on the button at the window’s lower left.

• Click in the list on the name of the family you want to view.  If a
family contains several “pages”, click on the “Right” and “Left”
buttons to flip through them.
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To attribute shaders directly to objects in a scene.

• Move the cursor onto the first shader in the Wood family.

Click and Drag

• Click on the shader and drag the cursor onto the wooden
bureau in the preview window.  Be sure to hold down the
mouse button.

4. Applying
a shader

O b j e c t i v e
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As soon as you release the mouse button, Art•lantis applies the
wood shader to the bureau.  The program works continuously,
meaning that the scene will be displayed and updated non-stop
from bottom to top. This means you can continue working on the
scene and you do not have to wait for a recalculation or update. 

To apply a shader to each material.

To choose a new shader:

• Choose a shader from a family. 
• Click on its icon in the family while holding down the mouse
button.
• Drag it onto the object in the preview window’s 3D scene
where you want to apply it.
• Release the mouse button.

The preview window will be updated immediately with the new
shader applied to the surface.

• Now apply shaders to the following objects:

• Chrome (1StdSurface) on the table legs
• Transparent (1StdSurface) on the table
• Transparent (1StdSurface) on the window
• Leather (2StdSurface) on the armchairs
• Wood (Wood) on the bureau

5. More
shaders... !
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• Coating (Coatings) on the wall
• BlindH2Colors (Decoration) on the balcony
• Mirror (Mirror) on the panel
• Line2CSmooth (Lines) on the floor  

you have just applied a shader to every object in the scene!
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To create and update a new shader family containing all the
shaders utilized in  the  Room Start scene

Once you have rendered the Room Start scene, you may add to
the shader library a new family containing all the shaders used in
the rendered design.  These shaders will be saved exactly as they
appear in the preview, with all their parameters of color,
brilliance, rugosity, orientation, etc.   

• To create a new shader family, you need to do the following:

• Open the shader library.  You do this by selecting the 
“Library” item from the “Window” menu in Art•lantis.

• Roll down the “File” menu.  Select the “Save Shader 
Family” option.  

You will see that a new family has been added to shader library.
The members of the family are, in fact, all the shaders that you
utilized to dress up your scene.   Additionally, notice that the
name of the new shader family is “Room Start”, as reflected in the
family selector button at the bottom of the Library interface.
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6. Save Shader
Family …

O b j e c t i v e
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• To update a shader family, you need to do the following:

• Change the shaders on some of the surfaces.   For 
example, you may change the shader on the column by 
selecting a marble shader from the marble family.

• Modify other elements in the scene in a similar manner as the
column.  
After modifying the textures in some elements in the scene, the
shaders in the family “Room Start” no longer correspond to the
shaders in the modified scene. Thus, you need to explicitly
update the family by repeating the initial process to save the
family;  namely, you need to...

• Click again on the “Save Shader Family” option of the File
menu.  
Because the “Room Start” family exists already in the list,
Art•lantis will convey to you such condition and will give you
the opportunity to validate the update.  

Tutorial • Exercise 1 • Rendering 23
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• Click on the OK button to validate the update 

The shader family will be updated in the Library interface.    
Art•lantis will suppress from the family all the shaders which
were replaced by the new shaders.  The new shaders will be, in
turn, reflected in the new family.    For instance, see how the
shader family below differs from the original family after we
applied the marble shader  on the column and updated the
library.  

The shader family  is organized by folder in the “Shaders” folder. 
You can see this organization in the picture below.  

Exercice 1   8/10/99 15:46  Page 24



Tutorial • Exercise 1 • Rendering 25

Notice that the shader family that you created also appears as a
folder named “Room Start.” The advantage of this organization
is that you may create an “:archive” of all the shaders utilized in a
scene.   In this way, you may distribute not only the file
containing your rendered design, but also the folder containing
all shaders used for rendering the file.    The design and the
shader folder  are easily identified and matched because they
have the same name. 
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To understand the “Roughness” parameter by experimenting with
its dialog box on one of the objects in the scene.

• Close the Library by clicking in the box at the upper left side
of the window.

Now click on an object in the scene.  The shader modification
dialog box for this object will be displayed. 

• Click on the mirror  (the surface on which you’ll apply the
Mirror shader).

A dialog box opens automatically and gives you different
adjustment options:  the color picker and its patch, the Shininess
sliding gauge, and the Roughness sliding gauge.  

7. A surface’s
"Roughness" 

O b j e c t i v e
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• Slide the Roughness gauge slightly to the right.

You’ll notice that the light spot’s concentration diminishes the
further you slide the cursor to the right.

The roughness lets you add more or less light to a surface.
Moving the cursor to the right gives you a more defined spot,
whereas sliding it to the left results in light that is more spread
out along the surface.

Of course, this parameter’s effects depend on the way objects are
positioned in relation to light sources.

Exercice 1   8/10/99 15:46  Page 27



Tutorial • Exercise 1 • Rendering28

To understand the “Shininess” parameter by experimenting with
its dialog box while modifying the shader applied to one of the
objects in the scene.

• Slide the Shininess gauge to the right.

You’ll notice that the mirror catches even more light when it has a
high level of shininess.  Likewise, a lower level gives the shader a
more matte appearance, and the object seems to absorb the
ambient light.

8. A
surface’s
"Shininess" 

O b j e c t i v e
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To use the Ray Tracing option in calculating a scene in the
preview window and to observe its effects on a reflective object,
like a mirror.

After you have clicked on the Mirror shader and attributed it to
the mural, you’ll notice that the material isn’t reflective.  In fact,
ray tracing requires longer calculation time, so by default, it is not
active.  To activate it:

•  Go to the "Options" menu and activate “Ray Tracing”.  When
the option is active, it will be checked in the menu.

• The first time you launch ray tracing, it may take a few
seconds to calculate the reflections.

9.
Ray
Tracing

Before After

O b j e c t i v e
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Remark:
To make sure that the preview mode remains rapid, 
we recommend leaving the ray tracing option inactive
until you need to see how ray tracing affects reflective 
objects in the scene. 

Caution:

If you select ray tracing for a scene that includes 
several objects whose shaders have a high level 
of shininess, the preview window’s update process 
could be slowed considerably.  To keep this calculation 
time to a minimum, we recommend that you watch
the indicator below the Shininess sliding gauge. 
When it is red, that means that the reflections 
will be calculated.  You can then choose whether or 
not to activate the option, based on the number of 
calculations to be carried out and the complexity 
of the scene.   

•  Deactivate “Ray tracing” in the "Options" menu by dragging
down to it.  The check mark will disappear and the option will
become inactive.
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To understand and master the Flip and Compass tools for
orienting shaders on diverse objects in the scene.

The "Flip" function helps you turn the shader around the object
the way you would turn a cube or die.   

The following example shows four successive Flips around a
cube: 

Click on the floor in the scene to select it and choose the shader,
Lines2Smooth.   

• Click once on the Flip button, then again, and then a third
time to return to the original orientation.

10.  
Flip and
the
compass

0 Flip 1st Flip 2nd Flip 3rd Flip 

O b j e c t i v e
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The “Compass” function helps you orient a shader on a surface
the way you would turn a piece of paper on the surface of a table.

• Use the same shader on the floor:  Lines2Smooth.   

• Click and move the compass “needle” with the cursor.  Orient
the shader to  45° then to 90°.

Remark:
Depending on your screen’s definition, the lines 
may appear imprecise.  Don’t worry:  when 
Art•lantis calculates the final image, it uses 
antialiasing.   

• Return the needle to 0°.
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To understand how to use the Color Table to change the geometry
and graduation of colors in a shader.

• Continue using the "Lines2Smooth" shader and click on the
floor to open the modification dialog box.

You’ll see the Color Table at the lower left portion of the dialog
box.  This table helps you change the color graduation easily.

To change the Color Table, click in the box near the line’s default
placement, redraw the curve with the cursor while holding down
the mouse button.

11.  
The color
table

O b j e c t i v e
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• Click and redraw the line to resemble the curves below. As
you make each change, watch how the pattern of the shader on
the floor changes in the preview window.

The Art•lantis Render Color Table helps you define the
graduation from one color to another for any shader that’s made
up of at least two colors.
In the floor example, the table defines the graduation between the
yellow and the green:

• a horizontal line at the top of the table (screen 1) tells Art•lantis
Render that the green color will be completely dominant.

• a horizontal line at the bottom of the table (screen 2) tells
Art•lantis Render that the yellow color will be completely
dominant.

1 2 3 4

Exercice 1   8/10/99 15:47  Page 34



Tutorial • Exercise 1 • Rendering 35

• a curve broken into “staircases” between the two horizontal
lines at the top and bottom of the table (screen 3) results in a
transition between the two colors, yellow and green, without a
graduation.   

• a curve with several “jags” (screen 4) results in a succession of
lines with dramatic graduations between the two colors.

• a more gentle curve without “jags” (screen 5, below) creates a
progressive graduation from one color to the other, in which the
two colors mix in a sort of transition zone.

Try designing other curves for this shader and study the results.
The color table is a sophisticated tool for creating a wide range of
color graduations.  The results will be different if the shader is
made of parallel lines, squares, or a more irregular material
(marble, for example).

It is important to experiment with the color table to see how it
affects each shader.  Design several types of curves.  You’ll soon
understand how the textures react to each type of curve and
you’ll be able to create more diverse and sophisticated surfaces.
Playing with the color table will help you to understand the
diversity and richness of color that you have available to you at
your fingertips.

5
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To understand and master the parameters for changing the size of
repeated patterns in a shader.

• Select the “Circles2Colors” shader from the “Floor” family
and apply it to the ceiling.  Its dialog box opens.   

• Move the cursor to the far left of the Proportion gauge, then to
the far right.

The Proportion gauge defines the relationship between the colors 
in a shader that has at least two colors in a repeating pattern, as
the ceiling in the above example:

- Cursor at the center of the gauge:  neutral position.  The colors
will be evenly distributed (circles and intervals between them).
- Cursor to the left:  the circles will be much smaller and the

12. 
Adjusting
Proportion
and Scale

O b j e c t i v e
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interval between them very large.

• Now click and slide the cursor to the left and then to the right
of the Scale gauge.   

• Choose the scale.   

The Scale gauge defines the relative size of the shader’s motif,
without affecting the proportion of the material’s colors.

A low level of Scaling results in small circles with a narrow
interval between circles, but with a constant distance between
each.  A higher level results in large circles, with large intervals
between them.  

The Proportion and Scale parameters apply to a wide range of
shaders in Art•lantis Render.  Regardless of the shader’s
individual geometry, these parameters function in the same way
for all shaders.   
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To modify a shader’s opacity and launch a ray tracing
calculation in the preview window by activating the
transparency option to see how it affects a glass object.

• Click on the table in the 3D scene to open its parameters
dialog, “Table: Transparent”.

• Slide the cursor to the right of the "Opacity" gauge to make
the material transparent.

• Now slide the refraction gauge (at left) slightly toward the
bottom.

• In the Options menu, activate the “Transparency” function,
then “Ray Tracing”.

13.
Transparency
and opacity

O b j e c t i v e
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The Opacity gauge indicates the material’s level of transparency: 

if you slide the cursor to the left, the material will be opaque; if to
the right, the material will be transparent.

The Refraction gauge adjusts the material its refraction index,
which defines the angle at which light rays deviate when they
meet a transparent material.  To better understand refraction,
think of a common example of this property:  when you partially
submerge a long object in water  (for  example, a tube or your arm
in your bathtub!), you notice that the part that’s immersed doesn’t
appear to be an extension of the part that’s outside the water.  The
object appears to be twisted or buckled — this is the deviation.
This phenomenon is called refraction.  The higher the refraction
index, the larger this angle of deviation will be.

Remark:
This option requires longer calculation time.  
The following is an example of 
a scene in which you can see the dramatic 
effects of the activated transparency option.

• Deactivate the Transparency and Ray tracing options.  you are
now ready to move to the next exercise.
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To experiment with the Zoom tools to work on precise details in
a 3D scene.  This tool will be illustrated by applying a texture
map to a vase.

• Activate the “Zoom” command in the “Options” menu. A
square will appear in the preview window.

• Reduce the square’s size by clicking on one of its angles and
sliding it until the square is the desired size.

• Center the square over the area you want to enlarge by
clicking on one of its edges and dragging it to the appropriate
part of the scene.

• Validate the zoom by clicking inside the square.  Art•lantis
launches an overall recalculation.

14. 
Zooming
and
Texture
Maps

O b j e c t i v e
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Remark:

Art•lantis Render keeps the first preview 
window in memory so that you can eventually 
return to the “Original size”. 

• Click on the vase to select it, then check “Apply texture” in its
dialog box.  

The following Texture Mapping dialog box opens:

• Click once on the “Create” button to load the image that
contains the texture you want to use.

A general dialog box opens that lets you select the image.  Choose
the image named “Bubbles.tga”.

Exercice 1   8/10/99 15:47  Page 41



Tutorial • Exercise 1 • Rendering42

• Open the image.

Remark:
Any image that’s been saved in PICT, TGA, JPEG
or BMP format can be used as a texture 
and can be mapped.   

A dialog box opens that asks you to choose either automatic
adjustment or to modify the texture’s dimensions (size).  To
modify the size manually, take into account the reduced size of
the vase in relation to the image’s original size: 

• Click on the “Size” button and enter the following values:
Width= 10 and Height = 10.

Exercice 1   8/10/99 15:47  Page 42



Tutorial • Exercise 1 • Rendering 43

• Validate your choice by clicking on the OK button.
The image appears in dialog box’s window.   

When you open the image, the texture will be positioned at the
center of the object by default.

To change the texture’s position on the vase:

• Hold down the “Ctrl” key and click on the part of the vase
where you want to place the center of the texture.  This new
point becomes the center of the texture map.
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To use the basic texture dialog box tools to orient and turn a
PICT texture on a 3D object.  To mask one of a map’s colors.  

• Move the compass needle to pivot the PICT to a position of
45°. 

15. Orienting
and masking
a texture

O b j e c t i v e
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• Return the compass needle to  0°. 

You can create a mask by deleting certain colors as a texture map
is applied.

• Check the box to the right of the upper round button.

The mask is defined either by a single color, two colors, or by a
range of colors between two color extremes. For more information
on masking, see the Masking section in the User’s Guide under
the Edit Shader sub-section.

• Activate the upper round button by clicking on it, then click on
the black part of the image in the dialog box.

Art•lantis Render eliminates the black color.  The image itself
isn’t affected — only the texture that’s been applied to the surface.
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To master the tools for repeating a texture horizontally or
vertically on an object surface.

In the dialog box, you’ll notice several other parameters for your
mapped image.  Around the compass, you’ll find the Repeat
boxes.  These tell Art•lantis Render to repeat the texture
horizontally, vertically, or both.

• Check the "H" box.  The image repeats horizontally around
the vase.

• Check the "V" box and the image repeats vertically.

16.
Repeating
a texture

O b j e c t i v e
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To modify the spacing between repeated textures.

• Slide the cursor slightly to the right along the Spacing gauge.
You’ll see the spacing between each map repetition increase.

17.
Spacing
textures

O b j e c t i v e
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The spacing value is determined by its relation to the texture
map’s reference size (indicated by “Size” in the dialog box after
you have selected the image).

• To undo the spacing, simply slide the cursor along the gauge
to the left.

Tutorial • Exercice 1 • Rendering48
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To master the tools for creating bump (relief) with an applied
texture map.  This process will be illustrated with a texture map
that has been rendered completely transparent.

The Bump (relief) function helps you simulate a 3D effect on a
material based on the luminosity of the applied image.

Before using the Bump function:

• Increase the mapped image’s luminosity by using the
Shininess and Roughness sliding gauges.

18. Texture
and Bump

O b j e c t i v e
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By changing the shininess and roughness levels, the image reacts
to the light sources in the scene and becomes more luminous.

To give the image bump (relief):

• Slide the cursor to the left along the Bump gauge.   

Notice the effect:  the Bump acts on the darkest parts of the motif
and gives them the appearance of being “sunken” or in shadow.

The red indicator (below the sliding gauge) lights up to tell you
that the Bump function is active and that the calculation time will
be longer.  

• Slide the cursor to the right.   
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You’ll see that the effect is the opposite: the texture “protrudes”
from the object’s surface.

The Bump function also helps you create a 3D effect by
suppressing the colors that make up the mapped image.  To
suppress the colors, simply make the image transparent.

• Slide the cursor to the right of the Opacity gauge. 
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The mapped image becomes invisible, but the relief (its texture)
remains and takes on the color of the vase (green).

If, for example, you superimpose several mapped images on an
object, the 3D effect will take the color of the image situated just
below it.

Remark:
To undo the Bump effect, simply click on the red 
indicator beneath the sliding gauge.  It will light 
up in green, indicating that the 3D effect is no 
longer active.

Exercice 1   8/10/99 15:47  Page 52



Tutorial • Exercice 1 • Rendering 53

To use texture maps to add people and vegetation to a 3D scene.

To give even more realism to a 3D scene, you can enrich it with
elements like people, plants, vehicles, etc.

To do this, you could, of course, try to use your favorite
retouching program to modify the image you have calculated in
Art•lantis Render — add a tree, a person, a panel, etc.  However,
you’ll have to manage its masking, background, foreground,
luminosity, and definition:  not always an easy task.  And
juggling so many parameters can be extremely time-consuming.  

But with Art•lantis Render, you can easily place 2D images into
a 3D scene.  In this exercise, you’ll place a person and vegetation
on the balcony.

With the help of a 3D modeler, we’ve created two faces
(polygons) which will be the support for the texture-mapped
images.   

For this exercise, you need to activate “Transparency” to apply
the textures to objects behind the window.    

19. Texture
and
preparing
a scene

O b j e c t i v e
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• Activate the “Transparency” option in the Options menu.

• Activate “Return to original size” in the Options menu, then
click inside the preview window to validate.

The original view reappears.  Note the two faces that have been
placed in the scene:  the first (1), outside the balcony (in the
complete background of the scene), is green and the second (2),
situated just behind the window,  is orange.   

• Click on the green face.  The dialog box for the “Tree” shader
will appear.   

(1)

(2)
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• Open the Shaders library and click on the “Invisible” shader
in the Decoration family.

•  Slide the shader onto the “Tree” polygon in the preview
window.  

The material becomes invisible, but is still present in the scene
and is used as support for your texture map.  

• Check the “Apply texture” box at the bottom of the Invisible
shader dialog box.

The texture mapping dialog appears.

• Click on “Create” then select “Leaves.tga” in the dialog.   

Keep the default options: “Keep proportion” and “Automatic 

Exercice 1   8/10/99 15:47  Page 55



Tutorial • Exercice 1 • Rendering56

adjustment”.

• Validate by clicking on OK.

The texture mapping dialog reappears and the “Leaves.tga”
image is applied to the polygon support in the 3D scene.   

• Use the following tools to adjust the texture map:

Repetition H & V

to repeat the “Leaves.tga” image over the entire material.

Mask

to suppress the white color in the “Leaves.tga” image.

Scale

to reduce the size of the image so it fits in with the rest of the
scene.
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The texture mapping dialog contains the following adjustment 
tools:

you have just simulated vegetation in the scene’s  background,
quickly and easily.
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Now place a person on the balcony:

• Click on the orange face.   The dialog box for the shader opens.

Apply the mapped image as you did with the leaves:

• • Apply the “Invisible” shader (from the Decoration family) to
the orange face.

The material becomes invisible, but is still present in the scene
and is used as a support for your texture map.  

• Check the “Apply texture” box at the bottom of the Invisible
shader dialog box.

The texture mapping dialog appears.

• Click on “Create” then select “Girl.tga” in the dialog.   

Keep the default options: “Keep proportion” and “Automatic
adjustment”.
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• Validate by clicking on OK.

The dialog box reappears and the “Girl.tga” is displayed in the 3D
scene.

• Adjust the texture map by using:

Mask

to suppress the white color in the “Girl.tga” image.
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you have now finished preparing the scene.  A comparison:
while 
you could try to do the same work with an image retouching
program, Art•lantis Render has a number of clear advantages:

• you can work quickly and easily.  
• the luminosity of the texture maps automatically 
corresponds to the rest of the 3D scene.
• Art•lantis Render can automatically calculate cast 
shadows, reflection, and transparency for each mapped 
element.
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To  modify directly in Art•lantis the attribution of materials to
the elements of a 3D scene

In Art•lantis, the elements of a 3D scene are differentiated
according to the materials which are attributed to the them.  For
instance, in the “Room Start” file, you may select in the preview
window all the four chairs simply by clicking on one of them.
Applying a “leather” shader to one of them also applies the
shader to the other three chairs.  This is possible because in the
modeling program all chairs were defined by the same material.  

Art•lantis allows you to break down the composition of  the
elements in the scene by giving you the ability to define
additional materials to which you can subsequently apply
different shaders.   You do not have to edit the file in the original
modeling program in order to define new materials; you may do
this right within Art•lantis!   In the Art•lantis tradition, this can
be done easily and conveniently.   The ability to create and delete
materials not only gives you greater flexibility to render your
designs, but makes your work more productive and efficient so
that you can dedicate all your time and creativity to your
renderings.  

To show you how this is done, let’s take the four chairs and re-
apply different materials to the armrests.   We will then apply a
different shader to the armrests of all the chairs.   Let’s begin...

• Select the “Reapply  material” option from the Windows
menu, as shown on the side picture.

20.
Modifying
the
materials
in a scene
O b j e c t i v e
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Art•lantis displays the dialog box shown below.

• In the dialog box, click on the “Select by  objects” option, as
shown below:
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• In your preview window, click one time on each of the eight
armrests.  You will notice that they appear as selected (grayed-
out) in the preview window, as shown below.  

Once the eight armrests are selected, 

• Click on the “Create” button of the “Reapply  material”
dialog box.    
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You will notice that a new material item is added to the list in the
“Reapply material” dialog box.   The default name for the new
material is “Property #25”.   

• Double-click on the default name in order to modify it. You
may  type the new name in the following dialog box. 

• Enter the name “armrests” and click on “OK” to validate the
name.  

You will see that the materials list is updated as follows : 

• Click on the “Reapply” button in order to finally redefine the
armrests as new materials.    
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You may now apply different shaders to the armrests.   You may
do so as follows:
• Go to the “Windows” menu and activate the item “Edit
Shaders.”
• Open the shader library by selecting the “Library” option of
the “Windows” menu.
• Choose any of the wood shaders available from the “Wood”
family. 
• Click on the shader thumbnail, keep the mouse button
pressed, and drag the shader to the armrests.  

You may modify other materials similarly.  As previously
mentioned, this new function gives you the ability to enrich your
renderings in a quicker manner because you do not  have to go
back to the modeling program to redefine the materials.  

Caution:
You must know, however, that the materials re-defined in
Art•lantis will not appear in the modeling program if you
eventually decide to open the file with the latter.  
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To modify a scene’s lighting before launching the final rendering
and to experiment with the “Cast shadows” option.

Having adjusted the materials and textures maps, you can now
practice modifying the ambient light over the scene by changing
from an interior lighting to an exterior “sun” light.

• Select “Edit Lights” in the Windows menu.

21.
Modifying a
scene’s
lighting

O b j e c t i v e
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• Diminish the intensity of the light named “L1” to temporarily
darken the scene’s interior lighting:  R=G=B=70.

To create a new light:

• Click on the “Create” button.  A dialog appears in which you
can type the name of the new source.  Double-click on this light in
the list and give it a name:  “Sun”, for example.   

Modify the source’s parameters: 

• Click on the “Sun” icon to light the scene with a sun-type light.
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• Modify its intensity:  R=G=B=100 

• Check the “Shadows” box to indicate that this source will cast
shadows.  Keep the value of shadow intensity at 80 to cast dark
shadows.

• Click on the “Projected view” button to change the source’s
position and direction.
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In the projected wireframe view:

• Move the active light source (Sun) to position it outside the
room.  Use the cube icon to change the type of projection (top,
front and side views are possible).
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To precisely indicate the new position of the “Sun”, enter the
following values:

• Close the “Edit Lights” dialog box.

To give more contrast between the lit zones and those in shadow: 

• Click on the floor in the projected view window to select it.

• Move the cursor toward the left of the Roughness gauge.

To see how the cast shadows actually appear in relation to the
light’s (“Sun”) position and direction:

• Activate the “Cast shadows” and “Ray Tracing” options, then
the “Recalculate” command in the Options menu.
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A general recalculation begins and you’ll see the cast shadows in
the preview window.

To improve the window’s transparency and diminish the impact
of the new light source on it:    

• Click on the window to select it.

• Slide the cursor to the right of the Roughness gauge and along
the Shininess gauge to the left.
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To understand and master the parameters related to the strength
of a light source in order to increase the realism of a 3D scene.  

The following exercise should help you achieve the stated
objective:

• Select the “Edit Shader” option from the Windows menu.  
• Select the shader “Circles 2 Colors”, from the Floor family.
• Click and drag this shader to the ceiling in the Preview
window.  

22.
Modifying the
strength of the
lights in a
scene

O b j e c t i v e
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• Click  on the “Edit Lights” option from the “Windows” menu.

• Select light L1 and modify its parameters so as to darken the
scene.  

• Slide the cursor  “Max. Light” towards the left so that the
value shown comes closer to 90.  

After changing this value, the scene would take an appearance
similar to the one shown below.  
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• Select light L2, which corresponds to a spotlight. 

• In the preview window, click on the upper part of the curved
wall (between the column and the mirror) while simultaneously
holding down the “Ctrl” key.   This indicates to L2 that it
should focus on the selected zone. 

You can immediately see, in the Preview window, that the
spotlight is now focused on the selected area. 
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• Slide the Spread gauge located in the Lights dialog box.   The
spread is the angle of aperture, and you should set this angle to
28° by sliding the gauge towards the left.  

In the Projected View  window ,  

• Choose the side view of the design by clicking on the right
side of the cube  icon at  the bottom of the  window.    
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• Slide the spot light with your mouse to a higher location by
simultaneously pressing the Alt and the Shift keys.  

Pressing the Alt key allows you to move the totality of the
spotlight, including its position and its direction.  
Pressing the Shit key allows you you to move the light along a
perfectly vertical, horizontal or diagonal axis, as shown by the
orange grid which appears as soon as you move the light.  

Of  course, you may specify the location of the spotlight by typing
the following values on the indicated fields of the Lights dialog
box. 

You can see in the Preview window that the wall is well lit by the
spotlight, but that the ceiling remains a bit dark.   You need to do
the following in order to brighten  the ceiling.  

• Slide the Power gauge towards the right so that the value in
the upper corner of the gauge interface becomes 80.  

We can immediately see in the Preview window that the ceiling
becomes better lit.  
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You can immediately see in the Preview window that the ceiling
becomes better lit.  

You may, in a similar fashion, augment or decrease the strength
of your lights.  The new “Power” parameter  gives you the ability
to increase the visibility of surfaces which may  not  be brightened
otherwise.    

• Close the Lights dialog box. 

You need to do the following in order to reduce the impact  of the
new intensity of the spotlight on the wall. 

• Click on the wall in order to select it.   The interface on the
left of our screen offers you a “Shininess” . 
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• Slide the “Shininess” gauge towards the left in order to give a
more opaque aspect to the wall.  
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To choose the correct rendering parameters (based on the elements
in the scene and the size of the image to be calculated), to adjust
them, and to launch the  final rendering calculation in immediate
or deferred  mode. 

During the  final rendering calculation, Art•lantis renders your
scene  with all the parameters (size of final image,  image type,
quality level ,etc.) that you specify.   The final rendering
calculation differs from the the calculation in the Preview window 
in that the latter is only a preview image.   You need to do the
following in order to launch the final rendering of a scene:

• Activate the “Render Fixed Cameras” item in the Render
menu.

A dialog opens that displays the different rendering parameters: 

23.
Launching
the final
calculation

O b j e c t i v e
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• Click on the “Folder” icon, select the “Tutorial 1” folder then
click on “Select Tutorial 1”.

• Give the image a name, for example, “Room.jpg”.

• In the “ Format” menu, select “JPEG”.

• Select "1024x768" in the “Size” menu.
In this dialog, there are nine different formats available: eight
standard formats and one open (“Special”) format.

• Activate  "Antialiasing" (Good), “Ray Tracing,”
“Transparency” and “Cast shadows” by checking their
respective boxes.
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To save the final image calculation parameters: click on the OK
button.

To launch the final rendered image: 

• Click on “Render now”.  Art•lantis Render launches the
calculation based on the parameters you have specified.  

You’ll see a window that shows you how the calculation is
progressing.  Note that the calculation is carried out from bottom
to top.

The window’s size will change depending on the image definition
you have selected.  For higher definitions, Art•lantis Render
resizes the calculated image in the window, while respecting the
Height/Width ratio.

The window contains different information about the calculation:

- the time elapsed from the beginning of the calculation
- estimated calculation time remaining
- the size of the available memory

At the end of the calculation, the rendered document will appear
in the same folder as the document containing your 3D scene and
will carry the name you chose.
- Room.jpg in the Tutorial 1 folder.

Deferring a rendering calculation allows you to maximize the
utilization of your computer.   This means that the processing-
intensive calculations can take place at the time when you are not
using your machine for interactive work.  You may defer the
rendering of single scene, a panorama, or a film.  
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In order to prepare a deferred rendering calculation:

• Click on the “Render later...” button of the Render Fixed
Cameras interface.  

• In the resulting dialog, type the name “Interior View.”

• Click on the OK button to validate the name 

The deferred rendering is then represented by a script which will
be ran with the specified parameters.  The script has the name
“Interior View.txt” and is saved in a folder named Scripts,
located in the Art•lantis folder.

In Exercise 4, we will see how  to launch the collection of deferred
renderings.  
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